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Plone 4 Basics: Pages, Links, Images & Video 

Course Overview 
All University of Louisville departments that have managed their own website in the past 
(using Plone 3) will be required to rebuild their site in the Plone 4 environment. The Site 
Administrators will be responsible for this task.  During the rebuilding process, or after 
the new site goes ‘live’ to the public, the Site Admin may have granted permission to 
others to take part in content contribution and/or editing. 

This course covers many of the basic tasks needed by contributors to add and modify 
pages for their UofL site via the Plone 4 Content Management System. The materials 
and step-by-step instructions are aimed at a non-technical user.  Participants will learn 
how to create new and edit existing pages and folders. We’ll utilize the TinyMCE visual 
editor to explore text formatting styles and lists.  You’ll learn the differences in internal 
and external e-mail and web page links as you practice these skills. Next, we’ll learn 
how to jazz up your site by uploading and adding photos that are ADA compliant, as 
well as cover the processes and instructions for adding videos.  Most importantly we’ll 
cover saving, previewing, and publishing your work… all new processes when using 
Plone 4. Come join us as we play in the Plone 4 sandbox! 

This documentation is written as part of Information Technology’s short 
course program, which is accompanied by face-to-face instruction. (JLV) 

Getting Started ‐ Login 
In order to add or modify content to your website you must first login. The login button 
can usually be found in the top right hand corner of your page. If it is not there, the 
theme you have installed may have it located elsewhere on the page. 

When you are prompted to login, or if you manually click the login button, you will be 
asked for your user ID and password.  These are your ULink login credentials. 

When you click login (or enter) you will be taken back to the page you were originally on 
except there will be a Green Toolbar across the top of the page. This is your new edit 
bar and is a sign that you are working in Plone 4 (& have edit permissions). 
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Plone 4’s Green Toolbar
 

The Green Toolbar has several tabs and functions depending upon your context.  Some 
of the functions on the toolbar can include: 

 Contents: Lists the contents of the folder you are currently in. It’s also the root of 
the folder where you will be able to make some changes to all contents. 

 View: View the default view of the current item 

 Edit: Opens the edit screen for the content item you are viewing.  If you are 
viewing the table of contents, this will let you edit the settings of the folder. 

 Rules:  Automatically perform an action on items under certain conditions, such 
as add a new item 

 Sharing:  Grant and modify the user permissions for the item you are viewing 

 Preview: View your page, as the public would see it, before you publish it 

 Actions: Dropdown menu allows you to cut, copy, paste, delete, or rename the 
current item. CAREFUL USING THE ACTIONS MENU! (See below) 

 Display:  Modify the default view of the current folder 

 Add new: Choose items from the dropdown that you would like to add to the 
current folder 

 State:  Change the workflow state of the current item (internal, external, etc.) 

The toolbar’s ‘Actions’ drop-down menu has a 
that should NOT be used! 

Delete function 

(Unless you want to trash what you’re working on) 

Choosing ‘Delete’ from the ‘Actions’ drop-down menu WILL DELETE 
whatever you’re on, whether it’s a page, folder, etc. 

Page 3 



         

  

 

 

 

  

 

  

 
  

 

How‐To: Add a New Page 
Once you login to the website, you will want to add and edit pages. 

NOTE: When creating and modifying pages you do so with a ‘generic’ visual editor 
that looks identical to all users and all sites. The page reflects the theme (template) you 
have chosen when you ‘Preview’ or ‘Publish’ the page. Therefore, the specific fonts 
and layout that correlate with your theme are not visible when editing the page. 

1.	 Navigate to your site’s home page (for class: the folder with your name) 

2.	 From the Green Toolbar, with the View tab chosen, click Add new > Page 

3. Click in the Title field and type: (your name’s) Page (example: Janet’s Page) 

4.	 In the Summary field type: The summary will describe the content and 
context of this page 

The Summary is NOT mandatory but will be used by search engines.  The 
Summary will NOT be visible on your page. 

5.	 Click in the Body Text field and type: Text Goes Here 
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IMPORTANT: 
If you are not ready to add text and the new page is still “Under Construction” do 
not say so, as this does not meet ADA requirements.
 
Just DON’T PUBLISH IT. Keep the page ‘State’ set as ‘Internal Draft’ until you 

are ready to externally publish the page.
 

6.	 Scroll to the bottom of the page and click Save 

VERY IMPORTANT: 
This page includes a Visual Editor and the ONLY WAY YOU SHOULD EXIT this 
page is to click Save or Cancel at the bottom of the page.  Exiting the page 
editor by clicking on the back arrow button of the browser or by clicking on a link 
will LOCK the page. 

Others can unlock the page BUT… if both you and another editor are modifying 
at the same time it will only save the changes from the last person that saves it, 
meaning none of the other person’s edits will be included! 

After you Save the page, it defaults to the View tab & verifies the changes were saved 

How‐To: Add and Edit Text on a Page 
Once a page is created, you can add, edit, and delete information. The most important 
information on the web page is text. 

1.	 Navigate to your page (i.e. Janet’s Page) and from the Green Toolbar click the 
Edit tab. If making multiple changes you may choose the Check out/in method. 

Page 5 



 

    

  

 

   

  

 

2.	 From the Body Text section, Select (highlight) the text: ‘Text Goes Here’ and 
delete this text. 

3.	 Type (title-use caps): If All the Seas Were One Sea 

4.	 Click Enter/Return key 

5.	 Type: If all the seas were one sea, and press Enter/Return 

6.	 Type: What a great sea that would be! and press Enter 

7.	 Type: And if all the trees were one tree, and press Enter 

8.	 Type: What a great tree that would be! and press Enter TWICE 

9.	 Type (title-use caps): Lengthening Days and press Enter 

10.	 Type: As the days grow longer and press Enter 

11.	 Type: The storms grow stronger. and press Enter 

12.	 Ignore the ‘Local CSS’ section (Cascading Style Sheets) since the style is 
predetermined by the template 

13.	 Scroll down to the Change note field and type: Added Nursery Rhymes (To 
access the change history, see illustration below step #14) 
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14. Click Save…
 

REMEMBER the VERY IMPORTANT note (with the orange star) on Page 5
 

To see the change notes, click History under the page title.
 
From there you can ‘View’, ‘Compare’ and ‘Revert’ to a previous revision.
 

IF YOU DELETE A PAGE, FOLDER, ETC. THE HISTORY IS ALSO DELETED… 

JUST LIKE THAT CONTENT NEVER EXISTED, SO YOU CANNOT RETRIEVE IT
 

About Text Formatting 
Plone offers a platform-independent WYSIWYG (‘What You See Is What You Get’) 
HTML editor, called TinyMCE (Tiny Moxiecode Content Editor), to add and edit text to 
the page. This editing interface helps non-technical contributors format the text of a 
web page, insert images, links, and create lists. Text formatting includes headings, bold 
and italics, and styles. 

NOTE: There are NO CHOICES OF FONT STYLES, as your departmental site 
theme (template) predetermines this. 

How‐To: Apply Text Formatting to a Page – Headings/Subheadings 

There are two types of headings used in Plone, Heading and Subheading. The title of 
the web page will appear as a Heading style. Notice that Heading text is larger (more 
pixels) than Subheading text, and Subheading text is larger than Normal text. 

1. Click the Edit tab in the Green Toolbar of the page (or use Check out/in method). 

2. Click in the first line If All the Seas Were One Sea 

3. Click the Style drop-down arrow and choose Subheading 

4. Repeat for the title of the 2nd Nursery Rhyme; click in the line Lengthening Days 

5. Click the Style drop-down arrow and choose Subheading 
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6. Scroll to the bottom and click Save 

Applying Text Formatting to a Page – Bold & Italics 

In Plone, the Bold and Italics buttons apply the logical styles Strong (bold) and 
Emphasis (italics).  This meets the Americans with Disabilities Act (ADA) standards for 
formatting text in web pages.  First, you should understand bold and italic formatting on 
the web. 

Bold Instead of Italics? 
Italics in print are used for a number of reasons, including book and movie titles, foreign 
words, mathematical variables, and for emphasis.  Unfortunately italic text is often not 
as clear on the Web, so many editors use bold face, or a combination of bold and italics, 
where italics alone would be used in print. 

Possible Semantic Uses of Bold & Italics 

 Warning Labels 
 Key concepts or key vocabulary items in a course 
 But using bold face to highlight every instance of emphatic intonation could be 

just a bit distracting within a long text but could be useful in visual browsers 

Possible Visual Uses of Bold & Italics 

 To make colored text or small text more distinct and legible
 

 For academic conventions, including
 

o	 Book and movie titles (e.g. Office Space) 

o	 Foreign words in an English text (e.g. “The Spanish word for cat is el gato.”) 
o Variables in math, science and computing text (e.g. x = 4)
 

 To make menu items, titles or navigation tools more distinct
 

	 Helping users on a visual browser scan for key concepts that may be delimited 
in another way (e.g. special punctuation) within the text 

	 For design-related purposes 
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How‐To: Apply Text Formatting to a Page – Bold & Italics 

1. Click the Edit tab in the Green Toolbar of the page 

2. Select (highlight) the text If All the Seas Were One Sea
 

The text is already bold because it is a subheading
 

3. Click the Italics ( I ) icon from the editing tools (to indicate this is a title of the 
rhyme) 

4. Repeat applying italics for Lengthening Days 

5. Select/highlight just the words great sea from the line ‘What a great sea that 
would be!’ and click the Bold (B) icon from the editing tools 

6. Select/highlight just the words great tree from the line ‘What a great tree that 
would be! 
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7. Optional: In the Change note field type: Added bold & italics 

8. Click Save 

How‐To: Apply Other Formatting Styles to a Page 
Additional styles are included for formatting your text. These include: Literal, Pull-quote, 
Call-out, and Clear floats 

1. Navigate to your folder 

2. Create a new page… Add new > Page 

3. Type: Format Example Page in the Title field 

4. Click in the Body Text field 

5. Type: This is Literal Text and press Enter/Return key 

6. Type: This is a Pull-Quote and press Enter 

7. Type: This is Call-out Text and press Enter 

8. Type: This is Clear floats Text and press Enter, TWICE (May not be working correctly) 

9. Type: This Discreet Text was Selected First and press Enter 

10. Type: This Highlighted Text was Selected First and press Enter 
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Now, apply formatting styles to the above text… 

11.	 Click in the first line (This is Literal Text) 

12.	 Click the Style-Text drop-down arrow and choose Literal 

13.	 Click in the line ‘This is a Pull-Quote’ 

14.	 From the Style drop-down arrow choose Pull-Quote and notice where the 
alignment of the text is and how the other lines wrap around it 

15. Click in the line ‘This is Call-out Text’ and choose Call-out from the Style drop-
down menu 
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16. Click in the line ‘This is Clear floats Text’ and choose Clear floats from the Style 
drop-down menu Clear floats may not be working correctly 

The following styles are under the Style-Selection menu meaning you must first 
select the text you want to apply the style to, then choose to make that text 
Discreet or to Highlight it. 

17.	 Select/highlight just the words Discreet Text from the line ‘This Discreet Text 
was Selected First’ and choose Discreet from the Style-Selection drop-down 
menu 

18.	 Select/highlight just the words Highlighted Text from the line ‘This Highlighted 
Text was Selected First’ and choose Highlight from the Style-Selection drop-
down menu 

19.	 To remove Discreet or Highlighted text, Select it, then choose: (remove style) 

20.	 Scroll to the bottom and click Save 
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‘Format Example Page’ with text formatting styles applied and the saved changes verified 

How‐To: Create Unordered, Ordered, and Definition Lists 
It is very common to input text on a web page in the form of a list. The visual editor has 
three types of lists to choose from: Unordered (bulleted), Ordered (numbered), and 
Definition (multi-level). 

1.	 Navigate to your folder 

2.	 Create a new page… Add new > Page 

3.	 Type: Examples of Lists in the Title field 

4.	 Click in the Summary field 

5.	 Type: This page will show the three types of lists: Unordered, Ordered, and 
Definition 

6.	 Click in the Body Text field 

7.	 Type: Unordered List 

8. Click the Style drop-down menu and choose Heading and press Enter/Return 

9.	 Type: Zoo Animals 

10. Click the Style drop-down menu and choose Subheading and press Enter 

11. Click the Unordered (Bullets) icon 

12. If necessary, click to reposition the cursor next to the bullet 
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13. Type: Elephants and press Enter 

14. Type: Gorillas and press Enter 

15. Type: Lions and press Enter 3 TIMES 

The Unordered List ends 

16. Type: Ordered List 

17. Click the Style drop-down menu and choose Heading and press Enter 

18. Type: Crossing the Street and press Enter 

19. Click the Style drop-down menu and choose Subheading and press Enter 

20. Click the Ordered (Numbered) icon 

21. If necessary, click to reposition the cursor next to the first numeral 

22. Type: Look Left and press Enter 

23. Type: Look Right and press Enter 

24. Type: Look Left Again and press Enter 3 TIMES 

The Ordered List ends 

25. Type: Definition List 

26. Click the Style drop-down menu and choose Heading and press Enter 

27. Click the Definition (Multi-level) icon 

28. Type: Elephant and notice how the Style menu indicates Definition term 

29. Press Enter 
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30.	 Type: A pachyderm 

31.	 From the Style drop-down menu choose Definition description, under the Lists 
category 

32.	 Notice the ‘description’ is normal text & indents under the ‘term’.  Press Enter 
TWICE 

33.	 Type: Gorilla 

34.	 From the Style drop-down menu choose Definition term, under the Lists 
category 

35.	 Notice the ‘term’ justifies to the left again and becomes bold, then press Enter 

36.	 Type: One of the great apes 

37.	 Choose Definition description from the Style menu 

38.	 Notice the ‘definition’ tabs/indents under the ‘term’, and then press Enter 

The Definition List ends 

39.	 Continue toggling back and forth via the Styles drop-down menu. The Definition 
term will always be bold and justified to the left. The Definition description will 
not be bold and will tab over to indent. 

40.	 Scroll to the bottom of the page and click Save 
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‘Example of Lists’ page with 3 types of lists and the saved changes verified 

Previewing and Publishing 
Plone 4’s Preview button allows you to view your site when editing, as the public would 
see it, before you publish it. The tab is located in the Green Toolbar of pages and 
folders. 

	 When using the visual editor, the TinyMCE interface looks the same for all 
departments. You should preview your edits before you publish, so you can see 
how the page will look with your department’s theme (template) applied.  You do 
not have a choice of fonts, so previewing is best way to see how the edited page 
will display using the site’s theme. 

 It’s simple… Before you publish, click the Preview tab. 

	 When in ‘Preview’ mode, click the browser back arrow (previous page) to
 
continue editing or to publish.
 

With Plone 4 you have to PUBLISH ALL pages, folders, 

events, news items, etc. for them to be visible!! 
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	 When creating new pages and folders, they automatically default to an ‘Internal 
draft’ state so you can publish later. 

The page is NOT VISIBLE to the public when it is an Internal draft 

	 Publish externally will make the page visible to the public. When you’re ready 
to publish, pull down the State drop-down menu and choose Publish 
externally. The State will now read: Externally visible. 

	 Publish internally / Internally published means the site visitor has to log in to 
see the page. Anybody that is in the Active Directory system (all faculty, staff, 
students, and sponsored accounts) would be able to log in and see the page. 

	 Publish restricted / Internally restricted also means that the site visitor has to 
log in to see the page. The difference is that you restrict who can see the page 
via the Sharing tab. Restricted requires them to have ‘Can view’ permission to 
access the content. 

	 To give restricted users permission OR to give edit permissions to pages: 

1.	 Click on the Sharing tab. 

2.	 For ‘Restricted’ users: Break the inheritance from higher levels by 
unchecking the checkbox. For other types of publishing or giving 
someone edit rights, you can keep the inheritance box checked. 

3.	 Add the specific users one at a time and choose their permission levels 
by checking the boxes next to the choices. You must at least choose 
‘Can View’.  Other levels include ‘Can Add’, ‘Can Edit’, and ‘Can Review’. 

4.	 Choose Save each time you add a name. 

Hint: Searching via userID (instead of lastname,firstname) will narrow 
the results to that specific person, therefore speeding up the process. 

	 If you publish the page (i.e. Externally visible, Internally published) and later want 
to manually pull the page and take it offline, choose Retract from the ‘State’ 
dropdown menu. The State will change back to ‘Internal draft’ and will not be 
visible to the public, but will still be available under the ‘Contents’ tab. 
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Once you Retract, the State changes to Internal draft 

If you Delete a page (folder, etc.) it will permanently delete and 

WILL NOT be recoverable.
 

If you just Retract, it will be remain stored under the Contents tab
 

To Publish Several Pages at Once:  (Step-by-step illustrations pages 34-35) 

1.	 Navigate to the Home Folder or the folder that contains the contents 

2.	 Click the Contents tab from the Green Toolbar 

3.	 The far right column will show you the ‘State’, making Internal draft 
contents easy to spot 

4.	 Select the checkboxes of the contents you want to publish 

5. Click the Change State button at the bottom of the contents 

6.	 The ‘Publishing process’ page gives you several options, like choosing 
a publishing date or an expiration date. An item is not publicly 
searchable before its publishing date.  You can also bypass the 
publishing date and expiration date, meaning the page will publish 
immediately when you click Save.  It will never expire until you Retract it 
manually. 

7.	 Click Save at the bottom 

Editing Content 
GOOD NEWS! 

Effective Oct. 28, 2013 ALL editors, as well as Site
 
Admins, can Edit content without Retracting.
 

Editing Directly vs. Check-out a Working Copy 

Editing directly or choosing to Check-out the content is a matter of preference 
and most importantly confidence in your editing skills. 

Editing Directly 

	 When content is ALREADY PUBLISHED, small changes can be edited by 
choosing the Edit tab first (editing directly), bypassing the ‘Check-out’ process. 
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	 When directly editing a page the changed page replaces the live page 
immediately when you click Save. 

	 Editing directly, without checking out first, doesn’t offer you a ‘safety net’ of being 
able to Preview your fully changed page and make sure it’s correct, without 
errors, before replacing the live page.  If errors exist they will immediately be 
visible to the public. 

	 As opposed to Retracting… While editing directly (without checking out) the 
public can view the current version. This is technically not the last saved version 
because you can revert to an older version via the ‘History’. 

Editing via a Working Copy 

	 After content is ALREADY PUBLISHED, if you need to make more than a small 
change, it is recommended that all Editors (including Site Admins) should Check- 
out the page and make edits in a ‘Working Copy’. (especially for adding images). 

	 Editing via the Check-out/Check-in cycle is a MUCH SAFER option for editing 
pages requiring more than just a quick edit. There’s no danger of messing up the 
live page if a mistake is made during the editing process. Again, direct editing 
makes the page live when you click Save, where checking out a Working Copy 
allows you to Preview the changes after you click Save, assuring that no spelling, 
grammar, or placement errors are ever visible.  You can Edit, Save, then Preview 
several times. The page will not go live until you Check-in the content. 

	 As opposed to Retracting… Working copy also makes it possible to keep the 
current published page (folder, event, news item, etc.) visible on the web while 
you are making revisions. When done working, the new modified page can be 
checked-in and will replace the current page. This works well for a page that you 
update often, and keeps the history of the old version, just in case. 

	 To do this, you ‘Check Out’ a version of the currently published page, which 
creates a ‘Working Copy’. You then make your edits and ‘Check In’ the working 
copy. Plone replaces the original with the new, in the exact same location and 
URL. The new page is now live.  The old version’s history is recorded. 

 From the Actions Drop-down menu choose Check out 
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 Two info messages appear letting you know you are in a ‘working copy’ and that 
Check-out was created, while the ‘State’ changes to Internal draft 

 Edit and Save your local copy of the published page. During this time, the 
original page is LOCKED.  No one else can edit the published version of that 
page while you have a working copy checked out. This prevents other changes 
from being made to the published version while you edit your copy. 

 A message lets you know that your edits were saved. 

 After you’re satisfied with the Preview, from the Actions menu, choose Check in 

 You are prompted to enter a Check-in message, then choose Check in 

 Your updated page will now be live and replace the published version and 
become the new published copy 

 NOTE: If you start making edits and decide not to save any of the changes, 
navigate to the working copy and from the Actions menu choose Cancel check-
out. You will be prompted to confirm that you want to Cancel checkout. 
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How‐To: Add an Internal E‐mail Link 
Internal e-mail is all email with an ‘@louisville.edu’ address.  All internal e-mail links 
must go through the University E-mail Gateway for processing.  This lessens the 
chance that e-mail crawlers will obtain your e-mail address for spam purposes.  Plone 4 
makes adding an internal e-mail link easy… a simple text highlight then icon selection. 

1.	 Navigate to your page ‘(your name’s) Page’ (i.e. Janet’s Page) 

2.	 Click the Edit tab to open the page editor (or choose the Check out/in method) 

3.	 In the Body Text field, position the cursor at the location you want the e-mail 
contact information to appear 

4.	 Type the contact information along with the name of the person, department, or 
service account to whom the e-mail will be directed 

2 Examples: 

5.	 Select/highlight the name (or department) 

2 Examples: 

6. Click on the UofL Mail (envelope) icon from the page editor tools and a 
dialog box opens 

7.	 Enter the E-mail Address in the appropriate field 

NOTE: Fields displaying the tiny red square are required 

8.	 The highlighted text should already appear in the Link Text field 

9.	 The Subject field is optional… 

 If left blank: The subject can be filled in by the website visitor (Left illustration) 

 If you fill this in: The incoming e-mail will always have this subject (Right illustration) 

2 Examples: 

Page 21 

http:louisville.edu


 

           

 

 

               
 

 
  

  

 
 

10.	 Click Insert 

11.	 Scroll to the bottom and Save the page 

12.	 When testing the link, it should open the University E-mail Gateway and the 
recipient’s address will be visible 

How‐To: Add an External E‐mail Link 
1.	 Open the page editor and place your cursor where you want to input text 

2.	 Enter the text for the e-mail link 

3. Select/highlight the text you want to be clickable 

4. Click on the Link (solid chain) icon from the page editor tools and a 
dialog box opens 

5. Click Mail from the left navigation list of libraries 

6. Enter the e-mail address and a subject in the appropriate fields 

7.	 Click Insert 

8.	 Scroll to the bottom and Save the page 

9.	 When testing the link, the computer’s default e-mail software will open and begin 
to compose a new e-mail with the recipient in the ‘To’ field 

How‐To: Add an External Hyperlink to Another Website 
An External hyperlink is a link to pages outside of your website. Don’t be fooled by 
the word ‘external’, thinking it means other than UofL. External links not only direct 
visitors to sites outside the university, they also include links to the University of 
Louisville’s main home page and to other UofL websites outside your department’s! 

In other words, an External link is used for all UofL sites not structured under your home 
page. 
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1.	 Open the page editor and place your cursor where you want to input text 

2.	 Enter the text for the link 

3. Select/highlight the descriptive text that refers to the link 

4. Click on the Link (solid chain) icon 
dialog box opens 

from the page editor tools and a 

5.	 Click External from the left navigation list of ‘Libraries’ 

6.	 Choose the protocol from the drop menu, only if the link is not  http:// (the 
default) 

7.	 Enter (paste) the rest of the URL (website address) in the empty field beside the 
protocol 

8. Click Preview to make sure you have the correct website and the link will work 

Make sure the site is visible in the Preview window. Preview is scrollable. 

9.	 Click Insert 

Page 23 



 

    
  

  

                   

  
 

 

 

 

 

10.	 Optional: To make the link stand out in the sentence, make the descriptive text 
Bold, either before or after it’s linked  (Changing the text to bold will not remove the 
link to the site) 

11.	 Scroll to the bottom and Save the page 

12.	 Test the hyperlink to make sure everything is copasetic 

How‐To: Add Internal Links to Other Pages on Your Site 
An Internal link is a link from one page in your website to another page in your 
website. Other UofL sites fall under External links. 

1. Navigate to your folder 

2. Create a new page… Add new > Page 

3. Type: Informational Links in the Title field 

4. Click in the Body Text field 

5. Type: Links to Pages in My Website 

6. From the Style drop-down menu choose Subheading and press Enter/Return 

7. Type: (your name’s) Page (example: Janet’s Page) 

8. Select/highlight all the text that refers to ‘your’ page 

9.	 Click on the Link (solid chain) icon from the page editor tools and a 
dialog box opens 

10.	 Under the Internal link ‘Link list’ click the radio button next to ‘your’ Page 
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The Internal Link list 
displays all pages already 
created on your website 

Click Insert 

11. In the Body Text press Enter to go to the next line 

12. Type: Format Example Page and select/highlight this text 

13. Click on the Link icon 

14. Choose the Format Example Page radio button 

15. Choose Insert 

16. On a new line type: Examples of Lists and select/highlight this text 

17. Click on the Link icon 
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18. Choose the Examples of Lists radio button, then click Insert 

19. On a new line type: Workshop Home, select it, then click on the Link icon 

20. Click Home from the left navigation list of Libraries 

21. From the ‘Link list’ choose the radio button for e to Plone 

The Home button Link 
list displays all folders 

already created on your 
website 

From the ‘Home’ Library, you can choose to link to other Folders, News, Events, etc. 

22. Click Insert 

23. DON’T FORGET… Scroll to the bottom and Save the page!! 
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24. Preview the folder to see what it will look like when your theme is applied 

The ‘Informational Link’ Page in Preview mode with the Organizational Theme 

How‐To: Add Anchors 
Anchors are used when a web page is long and won’t fit on the screen. They help site 
visitors jump to specific positions on the page. 

A good example of using anchors: If you have listed several ‘Frequently Asked 
Questions’ at the top of the page and they link to the answer (anchor) far down the page. 

1.	 Navigate to Examples of Lists page and choose Edit (or navigate to the page 
you want to add anchors to).  For anchors, it is recommended that you use the 
Check out/in method (IF ALREADY PUBLISHED) so you can preview and test 
your anchors that you have added or edited. 

2.	 In the Body Text area insert a blank line above the subheading ‘Unordered List’ 
and change that line to Normal paragraph 

3.	 Type: Unordered List - Ordered List - Definitions (Instead of a hyphen you may 
prefer to use the vertical bar. It is the key above enter/return. You must hold down shift and press 
the key – Note: On a PC it looks like a broken vertical bar) 
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4.	 Click on the HTML icon 

5.	 You are now in the HTML Source Editor (Be cautious of the changes you make here) 

6.	 Place your cursor between the HTML tag <p> and the words “Unordered List” then type 
the following: 

<a class="anchor-link" href="#unordered-list">Unordered List</a> 

7.	 Repeat for the other two anchor links (Ordered List and Definitions) 

8.	 Place your cursor in front of the heading Unordered List 
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9. Place your cursor after the HTML tag <h2> then type the following 

<h2><a name="unordered-list"></a>Unordered List</h2> 

10. Repeat for the other two headings (Ordered List and Definitions) 

11. Save the page 

12. Test the anchors from the View tab 

Page 29 



 

 
   

   

  
 

  
      

      
      

   

 

 

 

NOTE: Anchors work well when the page is long and will not fit on the screen. 
The link to the anchor makes that section visible in the window.  It does not 
necessarily put it at the top of the window, if the anchor location is already near 
the bottom of the page.  If you reduce your window size or are using a mobile 
device you will have a greater chance of the anchor appearing at the top. 
(See illustration, below) 

Click: 

On the left image… the Definition List is not visible in the window. When 
‘Definitions’ was clicked, from the top of the page, the window jumps 

down to make the Definition List visible (right image), but does not 
necessarily put it at the top of the window (since it is near the page 
bottom). Reducing window size always makes the anchor visible. 

To Create Anchors from Text Other Than Headings/Subheadings 

1.	 From the Examples of Lists page, click the Edit tab 

2.	 Scroll down in the Body Text and select/highlight the word Gorilla from the 
Definition List 

3. Click the Insert/Edit Anchor icon 

4. Type: Gorilla as the Anchor name 
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5.	 Click Insert to close the box 

6.	 Now, an Anchor icon appears beside the word Gorilla in the Definition List 

7.	 On the first row of the Body Text place the cursor to the right of the word 
Definitions (see next illustration) 

8.	 Type: (e.g. Gorilla) with the parentheses 

9.	 Select/highlight the text (e.g. Gorilla) 

10. Click the Link icon (solid chain) 

11. Choose Anchors from the list of Libraries on the left 

12. Choose the radio button beside Gorilla 

13. Click Insert to close the box 

14. Don’t forget to Save the page 

How‐To: Create a Folder and Upload Images (w/ADA Compliance) 

It is recommended that you create folders to store files and images. You can create as 
many folders as you like, according to how you want to organize your content. In this 
case we will create one folder to hold our images, but you can create as many folders, 
as needed. Make sure you choose ‘Folder’ and not ‘Form Folder’ (used to create forms). 
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1. Navigate to your folder (with your name) 

2. Create a new folder… Add new > Folder 

3. Type: Images Folder in the Title field 

4. Click Save 

5. From the Images Folder, Click Add new > Image 

6. Browse for your photo by clicking on Browse or Choose File at the bottom of the 
‘Add Image’ page, then search for the image 

7. Once your image is chosen, give it a name in the Title field 
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8.	 In the Description field, enter a description of the photo that will serve as ‘Alt 
Text’ for ADA Compliance.  This is the text that screen reader software will read, 
and gives details of the image, to the person with a visual impairment. 

Notes: 
	 It is NOT mandatory that you add a description when uploading images to the 

folder, IF YOU HIDE it from navigation. 

	 It IS mandatory (federal law) that you tag the photo with a description when 
adding the image to a page. Therefore, you can wait to add the Alt Text at 
the time of insertion, if desired; as long as the folder is not visible that 
includes the full list of pictures. 

9.	 Click Save 

10.	 You will see the picture has uploaded into the Images Folder 

11.	 Don’t forget to always Publish the Images Folder (or to keep the images folder 
published) so your photos will show up on your page.  You may want to hide the 
folder from the navigation pane, so the public doesn’t see the unused photos 
stored in the Images Folder.  (See the next topic) 

Keep in mind that if a photo has been added to a page and is not visible, you 
may not have the Images Folder published. The fix is to go to the Images Folder 
and publish it. The photo should show up on the page then. 
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How‐To: Exclude Folders from the Navigation Pane 
You may want to Exclude (hide) the Images Folder from navigation.  This way, the only 
photos that are accessible are the images you add to pages.  You can also hide any 
folder this way (e.g. your pdf folder) 

1. Navigate to your Images Folder 

2. Click the Edit tab from the Green Toolbar 

3. Click Settings from the Gray Bar – (w/blue text that turns green when hovering) 

4. Click the checkbox beside Exclude from navigation to activate this feature 

5. Click Save 

6. Navigate elsewhere & the Images Folder will disappear from the sidebar 
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How‐To: Access Hidden Folders & Contents for Publishing 
Once you hide a folder you need access to the folder to publish it.  You also may decide 
you want to publish several contents at once, or take a look at what is published and 
what is in internal draft state. 

1.	 Navigate to the folder with your name 

2.	 Click the Contents tab from the Green Toolbar 

The Contents tab gives you a great overall picture of the state of your 
entire website and you can easily see what has not been published yet. 

3.	 Select the checkbox beside the Images Folder (in the list) or select several 
checkboxes beside all of the contents to publish them all at one time. 

The example shown below was for test purposes, as you can see that everything 
is still in the Internal draft State. 

4.	 Choose Change State from the bottom, below the contents list 

State is 
indicated in 
the far right 

column 

5.	 Notice that after you click ‘Change State’ that there are also options to ‘Publish’ 
or ‘Expire’ on a certain date, if desired. 

o If the Publishing Date is left blank, it will be published immediately 
o If the Expiration Date is left blank, it will never expire (it will remain visible) 
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o	 Since you would want to publish the Images Folder immediately, and would 
not want it to expire at a certain date, you can leave the 2 above choices 
alone 

6. At the bottom of the Publishing Process page, choose to Publish the folder. 
(See page 11-12 for publishing option descriptions) 

6. Click Save 

How‐To: Add Images to Pages 
1. Navigate to the page you want to insert the image and click on the Edit tab. 

However… For replacing or adding images to already published pages it is 
recommended that you use the Check out/in method so you can Preview 
before it goes live. 

2. Click in the Body Text to place the cursor where you want the image to appear 

Cursor 

3. Click the Insert/edit Image (tree) icon and a dialog box opens 

4. Click Images Folder from the Image list 
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5. Click the radio button beside the image 

6.	 The details of the Image appear, including an image preview and description. 
The description field is Alt Text (required for ADA compliance). If you included 
a description when you uploaded the photo, it is listed in the field. You can also 
change the description, if needed. 

You cannot leave the Image description field blank when you are adding the 
photo to the page and be in compliance with the Americans with Disabilities Act. 

7. Choose the Alignment (the default is Inline with the text) 

8. Choose the Dimensions (Image size) 

9. Scroll to the bottom of the dialog box and click Insert to go back to the visual 
editor 
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Above: The Image Alignment was ‘Left’ 

Above: The Image Alignment was ‘Inline’ 

10. If satisfied with the results showing in the editor… Save the Page!! 

Don’t forget to Save the Page 

11. Preview the page to see what it will look like when your theme is applied 
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12. Repeat the recent actions for the next poem Lengthening Days by uploading 
another image, inserting the photo on the page, and Saving the page edits 

13. Preview the page again with the theme applied 

Tip: You can always revert to an older revision via the History link. If you revert to an 
older revision, your latest edits will not be lost, because every time you click Save that 
modification is listed in the History. (Top of page 7 shows a screenshot to access the link) 
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Uploading Videos & Adding Them To Your Site (w/ADA Compliance) 

IT has implemented a simple way to upload a video and add it to your site.  This server 
supports Apple products that may not utilize Flash, (e.g. iPad, iPhone, & iPod Touch). 

1.	 Login to IT’s Video Upload site with your ULink userid and password and it will 

open to the page in the screenshot https://netapps.louisville.edu/FlashManager/ 

2. Give your video a Title then click Browse or Choose File then click Upload. This could 
take a while (depending on the size of your video). 
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3. When the upload is complete there will be a Embed button. 

4. Now you are on the Video Information page. Go to the Non plone/UofL web 
page section and copy the HTML code. 

5. Paste the code where you want it on your webpage. 
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6.	 Your video MUST BE ADA compliant/accessible, meaning you must either: (A) 
provide a written transcript of the video or (B) create an .xml file that will sync the 
audio closed-captions with the video. 

A.	 Transcript: The transcript needs to include more than the text script.  It 
has to convey the same information as the video, including background 
sounds, effects, and music, if applicable.  For example… If the video includes 
natural sounds or sound effects of an ambulance’s siren, gunshot, fireworks, 
dogs barking, and these are relevant to the video, you must include them. If 
it’s a piece on Mozart and features Mozart music as the sound track, you 
must indicate that Mozart music is playing in the background. 

How-To:  Add a Transcript… 
 Click Insert to close the ‘Insert UofL Video’ dialog box, if it’s open 

 Add a File or Link for Accessibility that is HIGHLY VISIBLE and NEAR THE 
VIDEO 

Either… (choose file or link)
 

 FILE - Include a downloadable accessible file
 

It is recommended that you do not use ‘Word’ files, since everyone doesn’t 
have the software. Create an accessible pdf file or a plain text file composed 
with an application such as Notepad (PC) or TextEdit (Mac) OR…. 

TIP: FROM WORD APP CHOOSE: SAVE AS > PLAIN TEXT FILE 

 LINK - Insert a link to a new page with the transcript 

 Don’t forget to Save the page! 

B.	 Closed-Captioning: Create an .xml file and store in the captions folder 
or in a folder on your site, and continue with steps below.
 

See: How-To Create a .xml Closed-Captioned File
 
http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/how-
to/create-a-closed-caption-file 
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 The .xml file can be added to the Captions folder on the flash area by a 
simple Drag-and-Drop of the file into the folder 

PC	 Mac 

 The URL for the captions file will be the same as the video except it will have: 
/captions/filename.xml on the end (filename= the name of the file) 

My Example URL for the Video Source: 
http://video.louisville.edu/vod/ittraining/flying.flv 

My Example URL for the Captions Source: 
http://video.louisville.edu/vod/ittraining/captions/flying.xml 

How-To:  Add Closed-Captioning… 

 With the ‘Insert UofL Video’ from the flowplayer dialog box still open, click on 
the Captions tab 

 Enter the Source URL where the .xml file is stored (See: ‘My Example URL’ 
from above) 

 The captioning box is set to appear at the top. If you want the captioning box 
somewhere other than the top, fill in the Distance from bottom field in pixels 
(number of pixels from the bottom of the video). You may have to experiment 
with this. Make sure you type a px at the end of the number with no spaces. 

 Enter the Width and Height (in pixels) for the size of the captioning box. 
Example: If your video is 400 pixels wide, you could make the captioning box 
300 pixels wide. In this case you would type: 300px in the Width field. 

 The captioning background will be transparent with white text.  If you want the 
captioning box to have a different Background color or Text color, fill in the 
boxes. You can also fill in a custom Font size (in pixels). 

Plone recognizes the text for standard colors, like Black or Yellow.  You can 
also enter #Hexadecimal digits for RGB values, like #AD0000 for UofL red. 
Any color that is valid on the web can be entered. 

To see a list of suggested Web Hexidecimal color codes for UofL visit OCM’s 
Brand Graphics page and click on: in the sidebar. 

http://louisville.edu/ocm/brand http://louisville.edu/ocm/brand/color 

 Click Insert to close the dialog box and return to the page being edited. 

 Don’t forget to Save the page! 
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ALWAYS log out of Plone when you are finished! 
If you log out of your AD computer this will log you out of Plone, as well. 

Resources 

Plone 4 User Manual (from Plone.org) 

http://plone.org/documentation/manual/plone-4-user-manual 

For Site Admin and Advanced Support Questions, contact IT CMS Support: 

 Brandon Gaddie, brandon.gaddie@louisville.edu 

 Peter Wood, pete@louisville.edu 

 Sherry Roark, sherry.roark@louisville.edu 

RECOMMENDED: Join the UofL WebGuide ListServ for publishing support for web 
designers and editors. Take advantage of the WebGuide group technical forums (via 
ListServ e-mail) and interact with other web experts across campus. Posting your 
question to the group is easy, and you normally will have a suggested solution that day. 
The WebGuide group also meets once a month on the last Thursday of each month at 
3:30pm in the SAC, Room #307 (Room # may be changed but will be announced in the 
ListServ e-mail). These meetings are optional. 
https://listserv.louisville.edu/wa?A0=webguide 

Making Technology Accessible for Students with Disabilities from the UofL Disability 
Resource Center 

https://louisville.edu/disability/faculty-staff/making-technology-accessible-for-students-
with-disabilities 

Creating an Accessible PDF file from Microsoft Office 

Applications that are included in the Microsoft Office suite can create accessible PDF 
files natively 

http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/link/creating-accessible-pdf-
file-from-microsoft-office 

UofL Brand Graphics Policy from the Office of Communications and Marketing 

https://louisville.edu/ocm/policies-guidelines 

Web Content at UofL is a great resource that is managed by IT CMS Infrastructure 
Support. Check this site often for updates and additions. You can find information on 
upcoming training, flash video requests, news, ADA compliance how-tos, and other web 
info. Below you will find a number of actions available from the drop-down menus. 

https://louisville.edu/web (Below illustration contains screenshots that are not clickable links.) 
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One-on-One FREE 1-hour Plone 4 Theme Training Registration (Login Required) 
IT offers this training to support customers using university-provided themes. Training 
will be scheduled with each customer at his or her location. 
**MAKE SURE you have images needed to support creating your theme and have 
content in your staging site.  Go ahead and start building your site so you will have a list 
of tasks you would like to learn or a better idea of what you need help with. You will 
need to login first to register. 

http://louisville.edu/web/plone-training/training-request-form 

More HOW‐TO Tutorials and Descriptions: 

Create and Edit a Form (with links to detailed descriptions for each form field) 
http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/tutorial/form-tutorial 

Create an Event (Plone 4 allows you to notify customers of upcoming events) 
http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/how-to/create-an-event 

Create a News Item (a press release, announcement, news story) 
http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/how-to/create-a-news-item 

Create a Collection  (to group items in a virtual folder) 
http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/how-to/create-a-collection 

Add Collection Criteria (customize collections for specific data sets) 
http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/how-to/add-collection-criteria 

Use Local CSS (easier to use and more flexible than with Plone 3) 
http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/how-to/Use-local-css 
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Plone 4 User HelpCenter (UofL) 

http://louisville.edu/web/helpcenter/plone-4-user-helpcenter 

The Plone 4 User Helpcenter also has a link in the sidebar for Tutorials. 
http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/tutorial 

Current THEME Tutorials: 

Working with the Prime Time Marketing Theme shows how to get various pieces of 
the Prime Time Marketing theme to work.  Screenshots are included. Topics 
include: Theme Overview, Site Title, Hero Banner, Main Blockquote, Spotlight 
Portlet, Content Area, Setting the Prefooter, and Getting all Content on one Page. 

http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/tutorial/working-with-the-
prime-time-marketing-theme 

Working with the Internal Organizational Theme shows the body HTML code for the 
parts under the banner and the code for getting all the content on one page (useful 
for printing, presentation mode, etc.) 

http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/tutorial/working-with-the-
internal-organizational-theme 

IT Design Services: Help with the creation, editing, or migration of your Plone web 
site is available from IT Design Services.  The Web Design Team can build, edit, or 
convert your site to the latest version of Plone. 

In addition to web services, the Media Team can provide professional photography, 
video, and graphic design for an event, web site, & all your creative or marketing needs. 

IT Design Services Contacts: 

Shelia Marable – Asst. Mgr., Design & Print and Web Team Leader samara01@louisville.edu 

Heather Jones – Graphic Designer hlmitc01@louisville.edu 

More Information on IT Design: 

http://louisville.edu/it/departments/itech-xpress-and-printing-copier-management 

Advanced Self-Training (w3schools illustration below is a clickable link to the site) 

Page 46 

http://louisville.edu/it/departments/itech-xpress-and-printing-copier-management
mailto:hlmitc01@louisville.edu
mailto:samara01@louisville.edu
http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/tutorial/working-with-the
http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/tutorial/working-with-the
http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/tutorial
http://louisville.edu/web/helpcenter/plone-4-user-helpcenter


 

 
  

NOTES 
Check out this site for Advanced Tutorials: 
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	Getting Started ‐Login 
	In order to add or modify content to your website you must first login. The login button can usually be found in the top right hand corner of your page. If it is not there, the theme you have installed may have it located elsewhere on the page. 
	When you are prompted to login, or if you manually click the login button, you will be asked for your user ID and password.  These are your ULink login credentials. 
	Figure
	When you click login (or enter) you will be taken back to the page you were originally on except there will be a Green Toolbar across the top of the page. This is your new edit bar and is a sign that you are working in Plone 4 (& have edit permissions). 

	Plone 4’s Green Toolbar. 
	Plone 4’s Green Toolbar. 
	Figure
	The Green Toolbar has several tabs and functions depending upon your context.  Some of the functions on the toolbar can include:  Contents: Lists the contents of the folder you are currently in. It’s also the root of the folder where you will be able to make some changes to all contents.  View: View the default view of the current item  Edit: Opens the edit screen for the content item you are viewing.  If you are viewing the table of contents, this will let you edit the settings of the folder.  Rules:  
	The toolbar’s ‘Actions’ drop-down menu has a Delete function 
	The toolbar’s ‘Actions’ drop-down menu has a Delete function 
	Figure
	that should NOT be used! 

	(Unless you want to trash what you’re working on) 

	Choosing ‘Delete’ from the ‘Actions’ drop-down menu WILL DELETE whatever you’re on, whether it’s a page, folder, etc. 
	Choosing ‘Delete’ from the ‘Actions’ drop-down menu WILL DELETE whatever you’re on, whether it’s a page, folder, etc. 
	Figure


	How‐To: Add a New Page 
	How‐To: Add a New Page 
	Once you login to the website, you will want to add and edit pages. 
	NOTE: When creating and modifying pages you do so with a ‘generic’ visual editor that looks identical to all users and all sites. The page reflects the theme (template) you have chosen when you ‘Preview’ or ‘Publish’ the page. Therefore, the specific fonts and layout that correlate with your theme are not visible when editing the page. 
	1.. 
	1.. 
	1.. 
	Navigate to your site’s home page (for class: the folder with your name) 

	2.. 
	2.. 
	From the Green Toolbar, with the View tab chosen, click Add new > Page 

	3. 
	3. 
	Click in the Title field and type: (your name’s) Page (example: Janet’s Page) 

	4.. 
	4.. 
	In the Summary field type: The summary will describe the content and context of this page 


	Figure
	Figure
	The Summary is NOT mandatory but will be used by search engines.  The Summary will NOT be visible on your page. 
	5.. Click in the Body Text field and type: Text Goes Here 
	Figure
	IMPORTANT: 
	If you are not ready to add text and the new page is still “Under Construction” do 
	not say so, as this does not meet ADA requirements.. Just DON’T PUBLISH IT. Keep the page ‘State’ set as ‘Internal Draft’ until you .are ready to externally publish the page.. 
	6.. Scroll to the bottom of the page and click Save 
	Figure
	VERY IMPORTANT: 
	This page includes a Visual Editor and the ONLY WAY YOU SHOULD EXIT this page is to click Save or Cancel at the bottom of the page.  Exiting the page editor by clicking on the back arrow button of the browser or by clicking on a link will LOCK the page. 
	Others can unlock the page BUT… if both you and another editor are modifying at the same time it will only save the changes from the last person that saves it, meaning none of the other person’s edits will be included! 
	Figure
	After you Save the page, it defaults to the View tab & verifies the changes were saved 

	How‐To: Add and Edit Text on a Page 
	How‐To: Add and Edit Text on a Page 
	Once a page is created, you can add, edit, and delete information. The most important information on the web page is text. 
	1.. 
	1.. 
	1.. 
	Navigate to your page (i.e. Janet’s Page) and from the Green Toolbar click the Edit tab. If making multiple changes you may choose the Check out/in method. 

	2.. 
	2.. 
	From the Body Text section, Select (highlight) the text: ‘Text Goes Here’ and delete this text. 

	3.. 
	3.. 
	Type (title-use caps): If All the Seas Were One Sea 

	4.. 
	4.. 
	Click Enter/Return key 

	5.. 
	5.. 
	Type: If all the seas were one sea, and press Enter/Return 

	6.. 
	6.. 
	Type: What a great sea that would be! and press Enter 

	7.. 
	7.. 
	Type: And if all the trees were one tree, and press Enter 

	8.. 
	8.. 
	Type: What a great tree that would be! and press Enter TWICE 

	9.. 
	9.. 
	Type (title-use caps): Lengthening Days and press Enter 

	10.. 
	10.. 
	Type: As the days grow longer and press Enter 

	11.. 
	11.. 
	Type: The storms grow stronger. and press Enter 

	12.. 
	12.. 
	Ignore the ‘Local CSS’ section (Cascading Style Sheets) since the style is predetermined by the template 

	13.. 
	13.. 
	Scroll down to the Change note field and type: Added Nursery Rhymes (To access the change history, see illustration below step #14) 

	14. 
	14. 
	Click Save…. REMEMBER the VERY IMPORTANT note (with the orange star) on Page 5. 


	Figure
	Figure
	Figure
	Figure
	To see the change notes, click History under the page title.. From there you can ‘View’, ‘Compare’ and ‘Revert’ to a previous revision.. 
	IF YOU DELETE A PAGE, FOLDER, ETC. THE HISTORY IS ALSO DELETED… .JUST LIKE THAT CONTENT NEVER EXISTED, SO YOU CANNOT RETRIEVE IT. 

	About Text Formatting 
	About Text Formatting 
	Plone offers a platform-independent WYSIWYG (‘What You See Is What You Get’) HTML editor, called TinyMCE (Tiny Moxiecode Content Editor), to add and edit text to the page. This editing interface helps non-technical contributors format the text of a web page, insert images, links, and create lists. Text formatting includes headings, bold and italics, and styles. 
	NOTE: There are NO CHOICES OF FONT STYLES, as your departmental site theme (template) predetermines this. 

	How‐To: Apply Text Formatting to a Page – Headings/Subheadings 
	How‐To: Apply Text Formatting to a Page – Headings/Subheadings 
	There are two types of headings used in Plone, Heading and Subheading. The title of the web page will appear as a Heading style. Notice that Heading text is larger (more pixels) than Subheading text, and Subheading text is larger than Normal text. 
	1. 
	1. 
	1. 
	Click the Edit tab in the Green Toolbar of the page (or use Check out/in method). 

	2. 
	2. 
	Click in the first line If All the Seas Were One Sea 

	3. 
	3. 
	Click the Style drop-down arrow and choose Subheading 

	4. 
	4. 
	Repeat for the title of the 2Nursery Rhyme; click in the line Lengthening Days 
	nd 


	5. 
	5. 
	Click the Style drop-down arrow and choose Subheading 


	Figure
	Figure
	6. Scroll to the bottom and click Save 

	Applying Text Formatting to a Page – Bold & Italics 
	Applying Text Formatting to a Page – Bold & Italics 
	In Plone, the Bold and Italics buttons apply the logical styles Strong (bold) and Emphasis (italics).  This meets the Americans with Disabilities Act (ADA) standards for formatting text in web pages.  First, you should understand bold and italic formatting on the web. 
	Bold Instead of Italics? 
	Italics in print are used for a number of reasons, including book and movie titles, foreign words, mathematical variables, and for emphasis.  Unfortunately italic text is often not as clear on the Web, so many editors use bold face, or a combination of bold and italics, where italics alone would be used in print. 
	Possible Semantic Uses of Bold & Italics 
	 Warning Labels  Key concepts or key vocabulary items in a course  But using bold face to highlight every instance of emphatic intonation could be 
	just a bit distracting within a long text but could be useful in visual browsers 
	Possible Visual Uses of Bold & Italics 
	 To make colored text or small text more distinct and legible.  For academic conventions, including. 
	o. Book and movie titles (e.g. Office Space) 
	o. Book and movie titles (e.g. Office Space) 
	o. Book and movie titles (e.g. Office Space) 

	o. Foreign words in an English text (e.g. “The Spanish word for cat is el gato.”) 
	o. Foreign words in an English text (e.g. “The Spanish word for cat is el gato.”) 


	o Variables in math, science and computing text (e.g. x = 4).  To make menu items, titles or navigation tools more distinct. 
	. Helping users on a visual browser scan for key concepts that may be delimited in another way (e.g. special punctuation) within the text 
	. For design-related purposes 

	How‐To: Apply Text Formatting to a Page – Bold & Italics 
	How‐To: Apply Text Formatting to a Page – Bold & Italics 
	1. 
	1. 
	1. 
	Click the Edit tab in the Green Toolbar of the page 

	2. 
	2. 
	Select (highlight) the text If All the Seas Were One Sea. The text is already bold because it is a subheading. 

	3. 
	3. 
	Click the Italics ( I ) icon from the editing tools (to indicate this is a title of the rhyme) 

	4. 
	4. 
	Repeat applying italics for Lengthening Days 

	5. 
	5. 
	Select/highlight just the words great sea from the line ‘What a great sea that would be!’ and click the Bold (B) icon from the editing tools 

	6. 
	6. 
	Select/highlight just the words great tree from the line ‘What a great tree that would be! 


	Figure
	Figure
	Figure
	Figure
	7. Optional: In the Change note field type: Added bold & italics 
	Figure
	8. Click Save 

	How‐To: Apply Other Formatting Styles to a Page 
	How‐To: Apply Other Formatting Styles to a Page 
	Additional styles are included for formatting your text. These include: Literal, Pull-quote, Call-out, and Clear floats 
	1. 
	1. 
	1. 
	Navigate to your folder 

	2. 
	2. 
	Create a new page… Add new > Page 

	3. 
	3. 
	Type: Format Example Page in the Title field 

	4. 
	4. 
	Click in the Body Text field 

	5. 
	5. 
	Type: This is Literal Text and press Enter/Return key 

	6. 
	6. 
	Type: This is a Pull-Quote and press Enter 

	7. 
	7. 
	Type: This is Call-out Text and press Enter 

	8. 
	8. 
	Type: This is Clear floats Text and press Enter, TWICE (May not be working correctly) 

	9. 
	9. 
	Type: This Discreet Text was Selected First and press Enter 

	10. 
	10. 
	Type: This Highlighted Text was Selected First and press Enter 


	Figure
	Figure
	Now, apply formatting styles to the above text… 
	11.. 
	11.. 
	11.. 
	Click in the first line (This is Literal Text) 

	12.. 
	12.. 
	Click the Style-Text drop-down arrow and choose Literal 

	13.. 
	13.. 
	Click in the line ‘This is a Pull-Quote’ 

	14.. 
	14.. 
	From the Style drop-down arrow choose Pull-Quote and notice where the alignment of the text is and how the other lines wrap around it 

	15. 
	15. 
	Click in the line ‘This is Call-out Text’ and choose Call-out from the Style drop-down menu 

	16. 
	16. 
	Click in the line ‘This is Clear floats Text’ and choose Clear floats from the Style drop-down menu Clear floats may not be working correctly 


	Figure
	Figure
	Figure
	Figure
	The following styles are under the Style-Selection menu meaning you must first select the text you want to apply the style to, then choose to make that text Discreet or to Highlight it. 
	17.. 
	17.. 
	17.. 
	Select/highlight just the words Discreet Text from the line ‘This Discreet Text was Selected First’ and choose Discreet from the Style-Selection drop-down menu 

	18.. 
	18.. 
	Select/highlight just the words Highlighted Text from the line ‘This Highlighted Text was Selected First’ and choose Highlight from the Style-Selection drop-down menu 

	19.. 
	19.. 
	To remove Discreet or Highlighted text, Select it, then choose: (remove style) 

	20.. 
	20.. 
	Scroll to the bottom and click Save 


	Figure
	Figure
	Figure
	‘Format Example Page’ with text formatting styles applied and the saved changes verified 

	How‐To: Create Unordered, Ordered, and Definition Lists 
	How‐To: Create Unordered, Ordered, and Definition Lists 
	It is very common to input text on a web page in the form of a list. The visual editor has three types of lists to choose from: Unordered (bulleted), Ordered (numbered), and Definition (multi-level). 
	1.. 
	1.. 
	1.. 
	Navigate to your folder 

	2.. 
	2.. 
	Create a new page… Add new > Page 

	3.. 
	3.. 
	Type: Examples of Lists in the Title field 

	4.. 
	4.. 
	Click in the Summary field 

	5.. 
	5.. 
	Type: This page will show the three types of lists: Unordered, Ordered, and Definition 

	6.. 
	6.. 
	Click in the Body Text field 

	7.. 
	7.. 
	Type: Unordered List 

	8. 
	8. 
	Click the Style drop-down menu and choose Heading and press Enter/Return 

	9.. 
	9.. 
	Type: Zoo Animals 

	10. 
	10. 
	Click the Style drop-down menu and choose Subheading and press Enter 

	11. 
	11. 
	Click the Unordered (Bullets) icon 

	12. 
	12. 
	If necessary, click to reposition the cursor next to the bullet 

	13. 
	13. 
	Type: Elephants and press Enter 

	14. 
	14. 
	Type: Gorillas and press Enter 

	15. 
	15. 
	Type: Lions and press Enter 3 TIMES 


	Figure
	Figure
	Figure
	The Unordered List ends 
	The Unordered List ends 
	16. 
	16. 
	16. 
	Type: Ordered List 

	17. 
	17. 
	Click the Style drop-down menu and choose Heading and press Enter 

	18. 
	18. 
	Type: Crossing the Street and press Enter 

	19. 
	19. 
	Click the Style drop-down menu and choose Subheading and press Enter 

	20. 
	20. 
	Click the Ordered (Numbered) icon 

	21. 
	21. 
	If necessary, click to reposition the cursor next to the first numeral 

	22. 
	22. 
	Type: Look Left and press Enter 

	23. 
	23. 
	Type: Look Right and press Enter 

	24. 
	24. 
	Type: Look Left Again and press Enter 3 TIMES 


	Figure
	Figure

	The Ordered List ends 
	The Ordered List ends 
	25. 
	25. 
	25. 
	Type: Definition List 

	26. 
	26. 
	Click the Style drop-down menu and choose Heading and press Enter 

	27. 
	27. 
	Click the Definition (Multi-level) icon 

	28. 
	28. 
	Type: Elephant and notice how the Style menu indicates Definition term 

	29. 
	29. 
	Press Enter 

	30.. 
	30.. 
	Type: A pachyderm 

	31.. 
	31.. 
	From the Style drop-down menu choose Definition description, under the Lists category 

	32.. 
	32.. 
	Notice the ‘description’ is normal text & indents under the ‘term’.  Press Enter TWICE 

	33.. 
	33.. 
	Type: Gorilla 

	34.. 
	34.. 
	From the Style drop-down menu choose Definition term, under the Lists category 

	35.. 
	35.. 
	Notice the ‘term’ justifies to the left again and becomes bold, then press Enter 

	36.. 
	36.. 
	Type: One of the great apes 

	37.. 
	37.. 
	Choose Definition description from the Style menu 

	38.. 
	38.. 
	Notice the ‘definition’ tabs/indents under the ‘term’, and then press Enter 


	Figure
	Figure
	Figure
	Figure

	The Definition List ends 
	The Definition List ends 
	39.. 
	39.. 
	39.. 
	Continue toggling back and forth via the Styles drop-down menu. The Definition term will always be bold and justified to the left. The Definition description will not be bold and will tab over to indent. 

	40.. 
	40.. 
	Scroll to the bottom of the page and click Save 


	Figure
	‘Example of Lists’ page with 3 types of lists and the saved changes verified 


	Previewing and Publishing 
	Previewing and Publishing 
	Figure
	Plone 4’s Preview button allows you to view your site when editing, as the public would see it, before you publish it. The tab is located in the Green Toolbar of pages and folders. 
	. When using the visual editor, the TinyMCE interface looks the same for all departments. You should preview your edits before you publish, so you can see how the page will look with your department’s theme (template) applied.  You do not have a choice of fonts, so previewing is best way to see how the edited page will display using the site’s theme. 
	 It’s simple… Before you publish, click the Preview tab. 
	Figure
	. When in ‘Preview’ mode, click the browser back arrow (previous page) to. continue editing or to publish.. 
	Figure
	With Plone 4 you have to PUBLISH pages, folders, events, news items, etc. for them to be visible!! 
	With Plone 4 you have to PUBLISH pages, folders, events, news items, etc. for them to be visible!! 
	ALL 

	. When creating new pages and folders, they automatically default to an ‘Internal draft’ state so you can publish later. 
	The page is NOT VISIBLE to the public when it is an Internal draft 
	. Publish externally will make the page visible to the public. When you’re ready to publish, pull down the State drop-down menu and choose Publish externally. The State will now read: Externally visible. 
	Figure
	. Publish internally / Internally published means the site visitor has to log in to see the page. Anybody that is in the Active Directory system (all faculty, staff, students, and sponsored accounts) would be able to log in and see the page. 
	. Publish restricted / Internally restricted also means that the site visitor has to log in to see the page. The difference is that you restrict who can see the page via the Sharing tab. Restricted requires them to have ‘Can view’ permission to access the content. 
	. To give restricted users permission OR to give edit permissions to pages: 
	1.. 
	1.. 
	1.. 
	Click on the Sharing tab. 

	2.. 
	2.. 
	For ‘Restricted’ users: Break the inheritance from higher levels by unchecking the checkbox. For other types of publishing or giving someone edit rights, you can keep the inheritance box checked. 

	3.. 
	3.. 
	Add the specific users one at a time and choose their permission levels by checking the boxes next to the choices. You must at least choose ‘Can View’. Other levels include ‘Can Add’, ‘Can Edit’, and ‘Can Review’. 

	4.. 
	4.. 
	Choose Save each time you add a name. 


	Hint: Searching via userID (instead of lastname,firstname) will narrow the results to that specific person, therefore speeding up the process. 
	. If you publish the page (i.e. Externally visible, Internally published) and later want to manually pull the page and take it offline, choose Retract from the ‘State’ dropdown menu. The State will change back to ‘Internal draft’ and will not be visible to the public, but will still be available under the ‘Contents’ tab. 
	Figure
	Once you Retract, the State changes to Internal draft 
	Once you Retract, the State changes to Internal draft 
	Figure

	If you Delete a page (folder, etc.) it will permanently delete and .WILL NOT be recoverable.. If you just Retract, it will be remain stored under the Contents tab. 

	To Publish Several Pages at Once:  (Step-by-step illustrations pages 34-35) 
	To Publish Several Pages at Once:  (Step-by-step illustrations pages 34-35) 
	1.. 
	1.. 
	1.. 
	Navigate to the Home Folder or the folder that contains the contents 

	2.. 
	2.. 
	Click the Contents tab from the Green Toolbar 

	3.. 
	3.. 
	The far right column will show you the ‘State’, making Internal draft contents easy to spot 

	4.. 
	4.. 
	Select the checkboxes of the contents you want to publish 

	5. 
	5. 
	Click the Change State button at the bottom of the contents 

	6.. 
	6.. 
	The ‘Publishing process’ page gives you several options, like choosing a publishing date or an expiration date. An item is not publicly searchable before its publishing date.  You can also bypass the publishing date and expiration date, meaning the page will publish immediately when you click Save.  It will never expire until you Retract it manually. 

	7.. 
	7.. 
	Click Save at the bottom 





	Editing Content 
	Editing Content 
	GOOD NEWS! 
	Effective Oct. 28, 2013 ALL editors, as well as Site. Admins, can Edit content without Retracting.. 
	Editing Directly vs. Check-out a Working Copy 
	Editing Directly vs. Check-out a Working Copy 
	Editing directly or choosing to Check-out the content is a matter of preference and most importantly confidence in your editing skills. 

	Editing Directly 
	Editing Directly 
	. When content is ALREADY PUBLISHED, small changes can be edited by choosing the Edit tab first (editing directly), bypassing the ‘Check-out’ process. 
	Page 18 
	. When directly editing a page the changed page replaces the live page immediately when you click Save. 
	. Editing directly, without checking out first, doesn’t offer you a ‘safety net’ of being able to Preview your fully changed page and make sure it’s correct, without errors, before replacing the live page.  If errors exist they will immediately be visible to the public. 
	. As opposed to Retracting… While editing directly (without checking out) the public can view the current version. This is technically not the last saved version because you can revert to an older version via the ‘History’. 

	Editing via a Working Copy 
	Editing via a Working Copy 
	. After content is ALREADY PUBLISHED, if you need to make more than a small change, it is recommended that all Editors (including Site Admins) should Check- out the page and make edits in a ‘Working Copy’. (especially for adding images). 
	. Editing via the Check-out/Check-in cycle is a MUCH SAFER option for editing pages requiring more than just a quick edit. There’s no danger of messing up the live page if a mistake is made during the editing process. Again, direct editing makes the page live when you click Save, where checking out a Working Copy allows you to Preview the changes after you click Save, assuring that no spelling, grammar, or placement errors are ever visible.  You can Edit, Save, then Preview several times. The page will not
	. As opposed to Retracting… Working copy also makes it possible to keep the current published page (folder, event, news item, etc.) visible on the web while you are making revisions. When done working, the new modified page can be checked-in and will replace the current page. This works well for a page that you update often, and keeps the history of the old version, just in case. 
	. To do this, you ‘Check Out’ a version of the currently published page, which creates a ‘Working Copy’. You then make your edits and ‘Check In’ the working copy. Plone replaces the original with the new, in the exact same location and URL. The new page is now live.  The old version’s history is recorded. 
	
	
	
	

	From the Actions Drop-down menu choose Check out 

	
	
	

	Two info messages appear letting you know you are in a ‘working copy’ and that Check-out was created, while the ‘State’ changes to Internal draft 

	
	
	

	Edit and Save your local copy of the published page. During this time, the original page is LOCKED.  No one else can edit the published version of that page while you have a working copy checked out. This prevents other changes from being made to the published version while you edit your copy. 

	
	
	

	A message lets you know that your edits were saved. 

	
	
	

	After you’re satisfied with the Preview, from the Actions menu, choose Check in 

	
	
	

	You are prompted to enter a Check-in message, then choose Check in 

	
	
	

	Your updated page will now be live and replace the published version and become the new published copy 

	
	
	

	NOTE: If you start making edits and decide not to save any of the changes, navigate to the working copy and from the Actions menu choose Cancel check-out. You will be prompted to confirm that you want to Cancel checkout. 


	Figure
	Figure
	Figure
	Figure


	How‐To: Add an Internal E‐mail Link 
	How‐To: Add an Internal E‐mail Link 
	All internal e-mail links must go through the for processing.  This lessens the chance that e-mail crawlers will obtain your e-mail address for spam purposes.  Plone 4 makes adding an internal e-mail link easy… a simple text highlight then icon selection. 
	Internal e-mail is all email with an ‘@louisville.edu’ address.  
	University E-mail Gateway 

	1.. 
	1.. 
	1.. 
	Navigate to your page ‘(your name’s) Page’ (i.e. Janet’s Page) 

	2.. 
	2.. 
	Click the Edit tab to open the page editor (or choose the Check out/in method) 

	3.. 
	3.. 
	In the Body Text field, position the cursor at the location you want the e-mail contact information to appear 

	4.. 
	4.. 
	4.. 
	Type the contact information along with the name of the person, department, or service account to whom the e-mail will be directed 

	2 Examples: 

	5.. 
	5.. 
	Select/highlight the name (or department) 


	Figure
	2 Examples: 
	Figure
	6. Click on the UofL Mail (envelope) icon 
	from the page editor tools and a 
	Figure

	dialog box opens 
	7.. 
	7.. 
	7.. 
	Enter the E-mail Address in the appropriate field NOTE: Fields displaying the tiny red square are required 

	8.. 
	8.. 
	The highlighted text should already appear in the Link Text field 

	9.. 
	9.. 
	The Subject field is optional…  If left blank: The subject can be filled in by the website visitor (Left illustration)  If you fill this in: The incoming e-mail will always have this subject (Right illustration) 


	Figure
	2 Examples: 
	Figure
	Figure
	Page 21 
	Page 21 


	10.. 
	10.. 
	10.. 
	Click Insert 

	11.. 
	11.. 
	Scroll to the bottom and Save the page 

	12.. 
	12.. 
	When testing the link, it should open the and the recipient’s address will be visible 
	University E-mail Gateway 




	How‐To: Add an External E‐mail Link 
	How‐To: Add an External E‐mail Link 
	1.. 
	1.. 
	1.. 
	Open the page editor and place your cursor where you want to input text 

	2.. 
	2.. 
	Enter the text for the e-mail link 

	3. 
	3. 
	Select/highlight the text you want to be clickable 


	Figure
	4. Click on the Link (solid chain) icon from the page editor tools and a dialog box opens 
	5. 
	5. 
	5. 
	Click Mail from the left navigation list of libraries 

	6. 
	6. 
	Enter the e-mail address and a subject in the appropriate fields 

	7.. 
	7.. 
	Click Insert 

	8.. 
	8.. 
	Scroll to the bottom and Save the page 

	9.. 
	9.. 
	When testing the link, the computer’s default e-mail software will open and begin to compose a new e-mail with the recipient in the ‘To’ field 


	Figure
	Figure

	How‐To: Add an External Hyperlink to Another Website 
	How‐To: Add an External Hyperlink to Another Website 
	An External hyperlink is a link to pages outside of your website. Don’t be fooled by the word ‘external’, thinking it means other than UofL. External links not only direct visitors to sites outside the university, they also include links to the University of Louisville’s main home page and to other UofL websites outside your department’s! 
	In other words, an External link is used for all UofL sites not structured under your home page. 
	1.. 
	1.. 
	1.. 
	Open the page editor and place your cursor where you want to input text 

	2.. 
	2.. 
	Enter the text for the link 

	3. 
	3. 
	Select/highlight the descriptive text that refers to the link 


	Figure
	4. Click on the Link (solid chain) icon dialog box opens 
	from the page editor tools and a 
	5.. 
	5.. 
	5.. 
	Click External from the left navigation list of ‘Libraries’ 

	6.. 
	6.. 
	Choose the protocol from the drop menu, only if the link is not  http:// (the default) 

	7.. 
	7.. 
	Enter (paste) the rest of the URL (website address) in the empty field beside the protocol 

	8. 
	8. 
	Click Preview to make sure you have the correct website and the link will work 


	Figure
	Figure
	Figure
	Make sure the site is visible in the Preview window. Preview is scrollable. 
	Make sure the site is visible in the Preview window. Preview is scrollable. 
	9.. 
	9.. 
	9.. 
	Click Insert 

	10.. 
	10.. 
	Optional: To make the link stand out in the sentence, make the descriptive text Bold, either before or after it’s linked  (Changing the text to bold will not remove the link to the site) 

	11.. 
	11.. 
	Scroll to the bottom and Save the page 

	12.. 
	12.. 
	Test the hyperlink to make sure everything is copasetic 


	Figure


	How‐To: Add Internal Links to Other Pages on Your Site 
	How‐To: Add Internal Links to Other Pages on Your Site 
	An Internal link is a link from one page in your website to another page in your website. Other UofL sites fall under External links. 
	1. 
	1. 
	1. 
	Navigate to your folder 

	2. 
	2. 
	Create a new page… Add new > Page 

	3. 
	3. 
	Type: Informational Links in the Title field 

	4. 
	4. 
	Click in the Body Text field 

	5. 
	5. 
	Type: Links to Pages in My Website 

	6. 
	6. 
	From the Style drop-down menu choose Subheading and press Enter/Return 

	7. 
	7. 
	Type: (your name’s) Page (example: Janet’s Page) 

	8. 
	8. 
	Select/highlight all the text that refers to ‘your’ page 

	9.. 
	9.. 
	Click on the Link (solid chain) icon 


	Figure
	Figure
	from the page editor tools and a 
	Figure

	dialog box opens 
	10.. Under the Internal link ‘Link list’ click the radio button next to ‘your’ Page 
	Figure
	The Internal Link list displays all pages already created on your website 
	Click Insert 
	11. 
	11. 
	11. 
	In the Body Text press Enter to go to the next line 

	12. 
	12. 
	Type: Format Example Page and select/highlight this text 

	13. 
	13. 
	Click on the Link icon 

	14. 
	14. 
	Choose the Format Example Page radio button 

	15. 
	15. 
	Choose Insert 

	16. 
	16. 
	On a new line type: Examples of Lists and select/highlight this text 

	17. 
	17. 
	Click on the Link icon 


	Figure
	Caption
	Figure


	Figure
	Figure
	Figure
	Figure
	18. Choose the Examples of Lists radio button, then click Insert 
	Figure
	Figure
	19. 
	19. 
	19. 
	On a new line type: Workshop Home, select it, then click on the Link icon 

	20. 
	20. 
	Click Home from the left navigation list of Libraries 

	21. 
	21. 
	From the ‘Link list’ choose the radio button for e to Plone 


	Figure
	Figure
	The Home button Link list displays all folders already created on your website 
	From the ‘Home’ Library, you can choose to link to other Folders, News, Events, etc. 
	From the ‘Home’ Library, you can choose to link to other Folders, News, Events, etc. 
	22. 
	22. 
	22. 
	Click Insert 

	23. 
	23. 
	DON’T FORGET… Scroll to the bottom and Save the page!! 


	24. Preview the folder to see what it will look like when your theme is applied 
	Figure
	The ‘Informational Link’ Page in Preview mode with the Organizational Theme 


	How‐To: Add Anchors 
	How‐To: Add Anchors 
	Anchors are used when a web page is long and won’t fit on the screen. They help site visitors jump to specific positions on the page. 
	A good example of using anchors: If you have listed several ‘Frequently Asked Questions’ at the top of the page and they link to the answer (anchor) far down the page. 
	1.. 
	1.. 
	1.. 
	Navigate to Examples of Lists page and choose Edit (or navigate to the page you want to add anchors to).  For anchors, it is recommended that you use the Check out/in method (IF ALREADY PUBLISHED) so you can preview and test your anchors that you have added or edited. 

	2.. 
	2.. 
	In the Body Text area insert a blank line above the subheading ‘Unordered List’ and change that line to Normal paragraph 

	3.. 
	3.. 
	Type: Unordered List - Ordered List - Definitions (Instead of a hyphen you may prefer to use the vertical bar. It is the key above enter/return. You must hold down shift and press the key – Note: On a PC it looks like a broken vertical bar) 

	4.. 
	4.. 
	Click on the HTML icon 

	5.. 
	5.. 
	You are now in the HTML Source Editor (Be cautious of the changes you make here) 

	6.. 
	6.. 
	Place your cursor between the HTML tag <p> and the words “Unordered List” then type the following: 


	Figure
	<a class="anchor-link" href="#unordered-list">Unordered List</a> 
	Figure
	7.. 
	7.. 
	7.. 
	Repeat for the other two anchor links (Ordered List and Definitions) 

	8.. 
	8.. 
	Place your cursor in front of the heading Unordered List 

	9. 
	9. 
	9. 
	Place your cursor after the HTML tag <h2> then type the following 

	<h2><a name="unordered-list"></a>Unordered List</h2> 

	10. 
	10. 
	Repeat for the other two headings (Ordered List and Definitions) 

	11. 
	11. 
	Save the page 

	12. 
	12. 
	Test the anchors from the View tab 


	Figure
	NOTE: Anchors work well when the page is long and will not fit on the screen. The link to the anchor makes that section visible in the window.  It does not necessarily put it at the top of the window, if the anchor location is already near the bottom of the page.  If you reduce your window size or are using a mobile device you will have a greater chance of the anchor appearing at the top. 
	(See illustration, below) 
	Click: 
	Figure
	Figure
	On the left image… the Definition List is not visible in the window. When ‘Definitions’ was clicked, from the top of the page, the window jumps down to make the Definition List visible (right image), but does not necessarily put it at the top of the window (since it is near the page bottom). Reducing window size always makes the anchor visible. 
	To Create Anchors from Text Other Than Headings/Subheadings 
	To Create Anchors from Text Other Than Headings/Subheadings 
	1.. 
	1.. 
	1.. 
	From the Examples of Lists page, click the Edit tab 

	2.. 
	2.. 
	Scroll down in the Body Text and select/highlight the word Gorilla from the Definition List 

	3. 
	3. 
	Click the Insert/Edit Anchor icon 

	4. 
	4. 
	Type: Gorilla as the Anchor name 

	5.. 
	5.. 
	Click Insert to close the box 

	6.. 
	6.. 
	Now, an Anchor icon appears beside the word Gorilla in the Definition List 

	7.. 
	7.. 
	On the first row of the Body Text place the cursor to the right of the word Definitions (see next illustration) 

	8.. 
	8.. 
	Type: (e.g. Gorilla) with the parentheses 

	9.. 
	9.. 
	Select/highlight the text (e.g. Gorilla) 

	10. 
	10. 
	Click the Link icon (solid chain) 

	11. 
	11. 
	Choose Anchors from the list of Libraries on the left 

	12. 
	12. 
	Choose the radio button beside Gorilla 

	13. 
	13. 
	Click Insert to close the box 

	14. 
	14. 
	Don’t forget to Save the page 
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	Figure
	Figure
	Figure
	Figure
	Figure
	Figure
	Figure


	How‐To: Create a Folder and Upload Images (w/ADA Compliance) 
	How‐To: Create a Folder and Upload Images (w/ADA Compliance) 
	It is recommended that you create folders to store files and images. You can create as many folders as you like, according to how you want to organize your content. In this case we will create one folder to hold our images, but you can create as many folders, as needed. Make sure you choose ‘Folder’ and not ‘Form Folder’ (used to create forms). 
	1. 
	1. 
	1. 
	Navigate to your folder (with your name) 

	2. 
	2. 
	Create a new folder… Add new > Folder 

	3. 
	3. 
	Type: Images Folder in the Title field 

	4. 
	4. 
	Click Save 

	5. 
	5. 
	From the Images Folder, Click Add new > Image 

	6. 
	6. 
	Browse for your photo by clicking on Browse or Choose File at the bottom of the ‘Add Image’ page, then search for the image 

	7. 
	7. 
	Once your image is chosen, give it a name in the Title field 

	8.. 
	8.. 
	In the Description field, enter a description of the photo that will serve as ‘Alt Text’ for ADA Compliance.  This is the text that screen reader software will read, and gives details of the image, to the person with a visual impairment. 


	Figure
	Figure
	Figure
	Figure
	Notes: 
	. It is NOT mandatory that you add a description when uploading images to the folder, IF YOU HIDE it from navigation. 
	. It IS mandatory (federal law) that you tag the photo with a description when adding the image to a page. Therefore, you can wait to add the Alt Text at the time of insertion, if desired; as long as the folder is not visible that includes the full list of pictures. 
	Figure
	9.. 
	9.. 
	9.. 
	Click Save 

	10.. 
	10.. 
	You will see the picture has uploaded into the Images Folder 

	11.. 
	11.. 
	Don’t forget to always (or to keep the images folder published) so your photos will show up on your page.  You may want to hide the folder from the navigation pane, so the public doesn’t see the unused photos stored in the Images Folder.  (See the next topic) 
	Publish the Images Folder 



	Figure
	Keep in mind that if a photo has been added to a page and is not visible, you may not have the Images Folder published. The fix is to go to the Images Folder and publish it. The photo should show up on the page then. 

	How‐To: Exclude Folders from the Navigation Pane 
	How‐To: Exclude Folders from the Navigation Pane 
	You may want to Exclude (hide) the Images Folder from navigation.  This way, the only photos that are accessible are the images you add to pages.  You can also hide any folder this way (e.g. your pdf folder) 
	1. 
	1. 
	1. 
	Navigate to your Images Folder 

	2. 
	2. 
	Click the Edit tab from the Green Toolbar 

	3. 
	3. 
	Click Settings from the Gray Bar – (w/blue text that turns green when hovering) 

	4. 
	4. 
	Click the checkbox beside Exclude from navigation to activate this feature 

	5. 
	5. 
	Click Save 

	6. 
	6. 
	Navigate elsewhere & the Images Folder will disappear from the sidebar 


	Figure
	Figure
	Figure
	Figure

	How‐To: Access Hidden Folders & Contents for Publishing 
	How‐To: Access Hidden Folders & Contents for Publishing 
	Once you hide a folder you need access to the folder to publish it.  You also may decide you want to publish several contents at once, or take a look at what is published and what is in internal draft state. 
	1.. 
	1.. 
	1.. 
	Navigate to the folder with your name 

	2.. 
	2.. 
	Click the Contents tab from the Green Toolbar 


	Figure
	The Contents tab gives you a great overall picture of the state of your entire website and you can easily see what has not been published yet. 
	3.. 
	3.. 
	3.. 
	3.. 
	Select the checkbox beside the Images Folder (in the list) or select several checkboxes beside all of the contents to publish them all at one time. 

	The example shown below was for test purposes, as you can see that everything is still in the Internal draft State. 

	4.. 
	4.. 
	Choose Change State from the bottom, below the contents list 

	5.. 
	5.. 
	Notice that after you click ‘Change State’ that there are also options to ‘Publish’ or ‘Expire’ on a certain date, if desired. 


	State is indicated in the far right column 
	o If the Publishing Date is left blank, it will be published immediately 
	o If the Publishing Date is left blank, it will be published immediately 
	o If the Publishing Date is left blank, it will be published immediately 

	o If the Expiration Date is left blank, it will never expire (it will remain visible) 
	o If the Expiration Date is left blank, it will never expire (it will remain visible) 



	o. Since you would want to publish the Images Folder immediately, and would not want it to expire at a certain date, you can leave the 2 above choices alone 
	o. Since you would want to publish the Images Folder immediately, and would not want it to expire at a certain date, you can leave the 2 above choices alone 

	6. At the bottom of the Publishing Process page, choose to Publish the folder. 
	(See page 11-12 for publishing option descriptions) 
	Figure
	6. Click Save 

	How‐To: Add Images to Pages 
	How‐To: Add Images to Pages 
	1. Navigate to the page you want to insert the image and click on the Edit tab. However… For replacing or adding images to already published pages it is recommended that you use the Check out/in method so you can Preview 
	before it goes live. 
	2. 
	2. 
	2. 
	Click in the Body Text to place the cursor where you want the image to appear 

	3. 
	3. 
	Click the Insert/edit Image (tree) icon 


	Cursor 
	and a dialog box opens 
	Figure

	4. Click Images Folder from the Image list 
	Figure
	5. Click the radio button beside the image 
	Figure
	6.. 
	6.. 
	6.. 
	6.. 
	The details of the Image appear, including an image preview and description. The description field is Alt Text (required for ADA compliance). If you included a description when you uploaded the photo, it is listed in the field. You can also change the description, if needed. 

	You cannot leave the Image description field blank when you are adding the photo to the page and be in compliance with the Americans with Disabilities Act. 

	7. 
	7. 
	Choose the Alignment (the default is Inline with the text) 

	8. 
	8. 
	Choose the Dimensions (Image size) 

	9. 
	9. 
	Scroll to the bottom of the dialog box and click Insert to go back to the visual editor 


	Figure
	Figure
	Figure
	Above: The Image Alignment was ‘Left’ 
	Above: The Image Alignment was ‘Inline’ 
	Above: The Image Alignment was ‘Inline’ 
	10. 
	10. 
	10. 
	If satisfied with the results showing in the editor… Save the Page!! 

	11. 
	11. 
	Preview the page to see what it will look like when your theme is applied 

	12. 
	12. 
	Repeat the recent actions for the next poem Lengthening Days by uploading another image, inserting the photo on the page, and Saving the page edits 

	13. 
	13. 
	Preview the page again with the theme applied 


	Don’t forget to Save the Page 
	Figure
	Figure
	Figure
	Tip: You can always revert to an older revision via the History link. If you revert to an older revision, your latest edits will not be lost, because every time you click Save that modification is listed in the History. (Top of page 7 shows a screenshot to access the link) 
	Page 39 


	Uploading Videos & Adding Them To Your Site (w/ADA Compliance) 
	Uploading Videos & Adding Them To Your Site (w/ADA Compliance) 
	IT has implemented a simple way to upload a video and add it to your site.  This server supports Apple products that may not utilize Flash, (e.g. iPad, iPhone, & iPod Touch). 
	1.. 
	1.. 
	1.. 
	Login to with your ULink userid and password and it will open to the page in the screenshot 
	IT’s Video Upload site 
	/ 
	https://netapps.louisville.edu/FlashManager



	2. 
	2. 
	Give your video a Title then click Browse or Choose File then click Upload. This could take a while (depending on the size of your video). 


	Figure
	Figure
	3. When the upload is complete there will be a Embed button. 
	Figure
	4. 
	4. 
	4. 
	Now you are on the Video Information page. Go to the Non plone/UofL web page section and copy the HTML code. 

	5. 
	5. 
	Paste the code where you want it on your webpage. 

	6.. 
	6.. 
	Your video MUST BE ADA compliant/accessible, meaning you must either: (A) provide a written transcript of the video or (B) create an .xml file that will sync the audio closed-captions with the video. 


	Figure
	A.. Transcript: The transcript needs to include more than the text script.  It has to convey the same information as the video, including background sounds, effects, and music, if applicable.  For example… If the video includes natural sounds or sound effects of an ambulance’s siren, gunshot, fireworks, dogs barking, and these are relevant to the video, you must include them. If it’s a piece on Mozart and features Mozart music as the sound track, you must indicate that Mozart music is playing in the backgro
	How-To:  Add a Transcript… 
	
	
	
	

	Click Insert to close the ‘Insert UofL Video’ dialog box, if it’s open 

	
	
	

	Add a File or Link for Accessibility that is HIGHLY VISIBLE and NEAR THE VIDEO 


	Either… (choose file or link).  FILE -Include a downloadable accessible file. 
	It is recommended that you do not use ‘Word’ files, since everyone doesn’t have the software. Create an accessible pdf file or a plain text file composed with an application such as Notepad (PC) or TextEdit (Mac) OR…. 
	TIP: FROM WORD APP CHOOSE: SAVE AS > PLAIN TEXT FILE 
	 LINK -Insert a link to a new page with the transcript 
	Figure
	
	
	
	

	Don’t forget to Save the page! 

	B.. 
	B.. 
	Closed-Captioning: Create an .xml file and store in the captions folder 


	or in a folder on your site, and continue with steps below.. See: 
	How-To Create a .xml Closed-Captioned File. 

	-to/create-a-closed-caption-file 
	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/how

	The .xml file can be added to the Captions folder on the flash area by a simple Drag-and-Drop of the file into the folder 
	

	Figure
	Figure
	PC. Mac 
	The URL for the captions file will be the same as the video except it will have: /captions/filename.xml on the end (filename= the name of the file) 
	

	My Example URL for the Video Source: 
	http://video.louisville.edu/vod/ittraining/flying.flv 
	http://video.louisville.edu/vod/ittraining/flying.flv 
	http://video.louisville.edu/vod/ittraining/flying.flv 

	My Example URL for the Captions Source: 

	http://video.louisville.edu/vod/ittraining/captions/flying.xml 
	http://video.louisville.edu/vod/ittraining/captions/flying.xml 
	http://video.louisville.edu/vod/ittraining/captions/flying.xml 

	How-To:  Add Closed-Captioning… 
	
	
	
	

	With the ‘Insert UofL Video’ from the flowplayer dialog box still open, click on the Captions tab 

	
	
	

	Enter the Source URL where the .xml file is stored (See: ‘My Example URL’ from above) 

	
	
	

	The captioning box is set to appear at the top. If you want the captioning box somewhere other than the top, fill in the Distance from bottom field in pixels (number of pixels from the bottom of the video). You may have to experiment with this. Make sure you type a px at the end of the number with no spaces. 

	
	
	

	Enter the Width and Height (in pixels) for the size of the captioning box. Example: If your video is 400 pixels wide, you could make the captioning box 300 pixels wide. In this case you would type: 300px in the Width field. 

	
	
	

	The captioning background will be transparent with white text.  If you want the captioning box to have a different Background color or Text color, fill in the boxes. You can also fill in a custom Font size (in pixels). 


	Plone recognizes the text for standard colors, like Black or Yellow.  You can also enter #Hexadecimal digits for RGB values, like #AD0000 for UofL red. Any color that is valid on the web can be entered. 
	To see a list of suggested Web Hexidecimal color codes for UofL visit and click on: in the sidebar. 
	Figure
	OCM’s Brand Graphics page 

	http://louisville.edu/ocm/brand 
	http://louisville.edu/ocm/brand 
	http://louisville.edu/ocm/brand/color 

	
	
	
	

	Click Insert to close the dialog box and return to the page being edited. 

	
	
	

	Don’t forget to Save the page! 



	ALWAYS log out of Plone when you are finished! 
	ALWAYS log out of Plone when you are finished! 
	If you log out of your AD computer this will log you out of Plone, as well. 


	Resources 
	Resources 
	(from ) 
	Plone 4 User Manual 
	Plone.org

	http://plone.org/documentation/manual/plone-4-user-manual 
	http://plone.org/documentation/manual/plone-4-user-manual 

	For Site Admin and Advanced Support Questions, contact IT CMS Support: 
	
	
	
	

	Brandon Gaddie, 
	brandon.gaddie@louisville.edu 
	brandon.gaddie@louisville.edu 



	
	
	

	Peter Wood, 
	pete@louisville.edu 
	pete@louisville.edu 



	
	
	

	Sherry Roark, 
	sherry.roark@louisville.edu 
	sherry.roark@louisville.edu 




	RECOMMENDED: Join the for publishing support for web designers and editors. Take advantage of the WebGuide group technical forums (via ListServ e-mail) and interact with other web experts across campus. Posting your question to the group is easy, and you normally will have a suggested solution that day. 
	UofL WebGuide ListServ 

	The WebGuide group also meets once a month on the last Thursday of each month at 3:30pm in the SAC, Room #307 (Room # may be changed but will be announced in the ListServ e-mail). These meetings are optional. 
	https://listserv.louisville.edu/wa?A0=webguide 
	https://listserv.louisville.edu/wa?A0=webguide 

	from the UofL Disability Resource Center 
	Making Technology Accessible for Students with Disabilities 

	-with-disabilities 
	https://louisville.edu/disability/faculty-staff/making-technology-accessible-for-students

	Creating an Accessible PDF file from Microsoft Office 
	Creating an Accessible PDF file from Microsoft Office 

	Applications that are included in the Microsoft Office suite can create accessible PDF files natively 
	-file-from-microsoft-office 
	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/link/creating-accessible-pdf

	from the Office of Communications and Marketing 
	UofL Brand Graphics Policy 

	https://louisville.edu/ocm/policies-guidelines 
	https://louisville.edu/ocm/policies-guidelines 

	is a great resource that is managed by IT CMS Infrastructure Support. Check this site often for updates and additions. You can find information on upcoming training, flash video requests, news, ADA compliance how-tos, and other web info. Below you will find a number of actions available from the drop-down menus. 
	Web Content at UofL 

	(Below illustration contains screenshots that are not clickable links.) 
	https://louisville.edu/web 

	Figure
	One-on-One FREE 1-hour (Login Required) IT offers this training to support customers using university-provided themes. Training will be scheduled with each customer at his or her location. **MAKE SURE you have images needed to support creating your theme and have content in your staging site.  Go ahead and start building your site so you will have a list of tasks you would like to learn or a better idea of what you need help with. You will need to login first to register. 
	Plone 4 Theme Training Registration 

	http://louisville.edu/web/plone-training/training-request-form 
	http://louisville.edu/web/plone-training/training-request-form 


	More HOW‐TO Tutorials and Descriptions: 
	More HOW‐TO Tutorials and Descriptions: 
	(with links to detailed descriptions for each form field) 
	Create and Edit a Form 

	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/tutorial/form-tutorial 
	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/tutorial/form-tutorial 

	(Plone 4 allows you to notify customers of upcoming events) 
	Create an Event 

	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/how-to/create-an-event 
	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/how-to/create-an-event 

	(a press release, announcement, news story) 
	Create a News Item 

	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/how-to/create-a-news-item 
	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/how-to/create-a-news-item 

	(to group items in a virtual folder) 
	Create a Collection  

	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/how-to/create-a-collection 
	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/how-to/create-a-collection 

	(customize collections for specific data sets) 
	Add Collection Criteria 

	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/how-to/add-collection-criteria 
	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/how-to/add-collection-criteria 

	(easier to use and more flexible than with Plone 3) 
	Use Local CSS 

	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/how-to/Use-local-css 
	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/how-to/Use-local-css 

	(UofL) 
	Plone 4 User HelpCenter 

	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter 
	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter 

	The Plone 4 User Helpcenter also has a link in the sidebar for . 
	Tutorials

	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/tutorial 
	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/tutorial 

	Current THEME Tutorials: 
	shows how to get various pieces of the Prime Time Marketing theme to work.  Screenshots are included. Topics include: Theme Overview, Site Title, Hero Banner, Main Blockquote, Spotlight Portlet, Content Area, Setting the Prefooter, and Getting all Content on one Page. 
	Working with the Prime Time Marketing Theme 

	-prime-time-marketing-theme 
	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/tutorial/working-with-the

	shows the body HTML code for the parts under the banner and the code for getting all the content on one page (useful for printing, presentation mode, etc.) 
	Working with the Internal Organizational Theme 

	-internal-organizational-theme 
	http://louisville.edu/web/helpcenter/plone-4-user-helpcenter/tutorial/working-with-the

	IT Design Services: Help with the creation, editing, or migration of your Plone web site is available from IT Design Services.  The Web Design Team can build, edit, or convert your site to the latest version of Plone. 
	In addition to web services, the Media Team can provide professional photography, video, and graphic design for an event, web site, & all your creative or marketing needs. 
	IT Design Services Contacts: 
	Shelia Marable – Asst. Mgr., Design & Print and Web Team Leader 
	samara01@louisville.edu 
	samara01@louisville.edu 


	Heather Jones – Graphic Designer 
	hlmitc01@louisville.edu 
	hlmitc01@louisville.edu 


	More Information on IT Design: 
	More Information on IT Design: 

	http://louisville.edu/it/departments/itech-xpress-and-printing-copier-management 
	http://louisville.edu/it/departments/itech-xpress-and-printing-copier-management 

	Advanced Self-Training 
	(w3schools illustration below is a clickable link to the site) 
	Figure

	NOTES 
	Check out this site for Advanced Tutorials: 
	Figure




